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RESUMO 
As Geotecnologias são ferramentas básicas e bastante utilizadas no planeamento urbano, na gestão de recursos hídricos 
e em estudos de susceptibilidade erosiva como deslizamentos de terra e inundações por serem capazes de obter 
informações confiáveis e de baixo custo sejam elas qualitativas e/ou quantitativas. O presente artigo objetivou avaliar 
o grau de Susceptibilidade as Inundações no Município de Tete – Província de Tete e realizar a caracterização 
morfométrica da Bacia Hidrográfica do Zambeze (BHZ) na Cidade de Tete. Esta pesquisa teve como base os 
parâmetros Morfométricos na identificação de áreas susceptíveis a inundações. Os procedimentos metodológicos 
cingiram-se em pesquisa bibliográfica, trabalho de gabinete, aplicação de técnicas de geoprocessamento em ambiente 
SIG, através do software ArcMap 10.5. Os resultados da pesquisa mostram que a área de estudo possui uma área de 
aproximadamente 287 Km² e um perímetro de 86,08 km, abrangendo nove (9) bairros. Com base no cálculo dos 
índices morfométricos, obteve-se os seguintes valores: índice de factor forma (0,54), coeficiente de compacidade 
(1,44) e índice de circularidade (0,48) e consoante a sua topografia possui um relevo predominantemente plano. A 
soma desses fatores permitiu concluir que a BHZ na Cidade Tete possui uma tendência média a susceptibilidade de 
gerar grandes inundações ou picos de enchentes, principalmente no lado Sul da Cidade. 
Palavras-chave: riscos; planeamento ambiental; inundações; vulnerabilidade sócio-ambiental. 
 
ABSTRACT 
Geotechnologies are basic and widely used tools in urban planning, water resources management and erosive 
susceptibility studies such as landslides and floods, as they are able to obtain reliable and low-cost information, 
whether qualitative and/or quantitative. The present article aimed to evaluate the degree of Susceptibility to Floods in 
the Municipality of Tete - Province of Tete - and to carry out the morphometric characterization of the Zambezi River 
Basin (BHZ) in the City of Tete. This research was based on Morphometric parameters in the identification of areas 
susceptible to flooding. The methodological procedures were limited to bibliographic research, office work and 
application of geoprocessing techniques in a GIS environment through ArcMap 10.5 software. The survey results 
show that the study area has an area of approximately 287 km² and a perimeter of 86.08 km, covering nine (9) 
neighborhoods. Based on the calculation of the morphometric indices, the following values were obtained: form factor 
index (0.54), compactness coefficient (1.44) and circularity index (0.48), and in relation to its topography it has a 
predominantly flat relief. The sum of these factors allowed us to conclude that the BHZ in Tete City has an average 
tendency to susceptibility to generate large floods or flood peaks, mainly on the south side of the city. 
KEYWORDS: risks; environmental planning; floodings; socio-environmental vulnerability. 
 
RESUMEN 
Las geotecnologías son herramientas básicas y ampliamente utilizadas en la planificación urbana, en la gestión de los 
recursos hídricos y en los estudios de susceptibilidad erosiva como deslizamientos e inundaciones, ya que son capaces 
de obtener información confiable y de bajo costo, ya sea cualitativa y/o cuantitativa. El presente artículo tuvo como 
objetivo evaluar el grado de Susceptibilidad a Inundaciones en el Municipio de Tete - Provincia de Tete - y realizar la 
caracterización morfométrica de la Cuenca del Zambezi (BHZ) en la Ciudad de Tete. Esta investigación se basó en 
parámetros Morfométricos en la identificación de áreas susceptibles a inundaciones. Los procedimientos 
metodológicos se limitaron a la búsqueda bibliográfica, trabajo de oficina y aplicación de técnicas de 
geoprocesamiento en un ambiente SIG, a través del software ArcMap 10.5. Los resultados de la investigación muestran 
que el área de estudio tiene una superficie aproximada de 287 km² y un perímetro de 86.08 km, abarcando nueve (9) 
barrios. En base al cálculo de los índices morfométricos se obtuvieron los siguientes valores: índice de factor de forma 
(0.54), coeficiente de compacidad (1.44) e índice de circularidad (0.48), y con respecto a su topografía presenta un 
relieve predominantemente plano. La suma de estos factores nos permitió concluir que la BHZ de la ciudad de Tete 
tiene una tendencia media a la susceptibilidad a generar grandes inundaciones o picos de inundación, principalmente 
en el lado sur de la ciudad. 
PALABRAS-CLAVE: riesgos, planificación ambiental; inundaciones, vulnerabilidad socioambiental. 
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INTRODUÇÃO 

 

Moçambique é um país que dada a sua localização fisiográfica é frequentemente afetado 

por eventos climáticos extremos, notadamente: ciclones, cheias e secas que consubstancia, por um 

lado, as alterações climáticas. Estima-se que em Moçambique cerca de 60% da população vive ou 

habitam nas costas e margens dos rios, estando assim expostos aos eventos climáticos e 

hidrológicos, o que lhes propicia, portanto, maior vulnerabilidade à tempestades tropicais, cheias 

e inundações, só para citar alguns exemplos.  

A Cidade de Tete1 encontra-se situada entre as margens do Rio Zambeze, um dos maiores 

rios e mais importantes que atravessa o território nacional, com cerca de 2.600 km de comprimento. 

Portanto, é o 26º rio mais comprido do Mundo e o 4º em África, depois de Nilo (6.700 km) Zaire 

(4.600 km) e Níger (4.200 km) (MUCHANGOS, 1999). A bacia hidrográfica possui cerca de 

1.330.000 km2, dos quais só 3.000 km2 em território moçambicano facto que confere-a, maior 

susceptibilidade a eventos hidrológicos. A esse respeito, PADCT (2015) afirma que a “Cidade de 

Tete é uma Cidade de alto risco por ser afectada por cheias”. Este fato é exacerbado pelo 

armazenamento da Albufeira de Cahora Bassa que é afectado pela capacidade de armazenamento 

das grandes Albufeiras de Kariba e Itezhi-Tezhi que se encontram à montante. 

O fenómeno das inundações é um evento natural, que se caracteriza pelo extravasamento 

da água do leito normal do rio, facto propiciado por precipitações intensas fazendo com que a 

quantidade de água que chega simultaneamente para um ponto do rio seja maior do que sua 

capacidade de escoamento (DEFESA CIVIL, 1996 apud PROCHMAN, 2014). A mesma fonte 

refere que as inundações nas áreas urbanas acarretam transtornos e prejuízos para a população, e 

muitas vezes resultam em vítimas, se agravando em função do aumento da urbanização, o uso 

indevido da terra, assoreamento dos rios e principalmente a ocupação das áreas susceptíveis à 

inundação.  

 
1Cidade de Tete é a capital da Província do mesmo nome na região central de Moçambique. Em termos históricos, 
esta cidade era um centro comercial swahili quando se estabeleceu o domínio português por volta 1530 (SILVA, 2013 
apud MACUVEIA, 2019). 
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A Cidade de Tete é considerada como uma Cidade de alto risco de ser afectada por cheias 

por esta se localizar a jusante de três barragens hidroeléctricas. À luz do Artigo 7º da Lei nº 15/2014 

de 20 de Junho, que estabelece o Regime Jurídico da Gestão das Calamidades (RJGC), refere que:  

 

Compete aos governos provinciais e ao representante do Estado na autarquia definir, no 
prazo de 180 dias após a entrada em vigor da Lei, as zonas de risco de calamidades nas 
respectivas áreas de jurisdição, onde é interdita a construção de habitações, mercados e 
outras infra-estruturas, excepto mediante aplicação de tecnologias de construção 
adequadas.  

 

Porém, apesar disso, até então constatamos que não existe um estudo exaustivo que possa 

responder a problemática acima levantada, apesar de, o Município de Tete ter identificado alguns 

pontos, como é o caso do Vale do Nhartanda. É diante disso que o estudo se propõe a dissertar, 

pela necessidade de mapear as áreas susceptíveis á inundações na Cidade de Tete, por meio de 

cálculos dos parâmetros morfométricos e, deste modo, apresentar a importância do estudo numa 

área urbana como subsídio ao processo de tomada de decisões no planeamento físico no que tange 

a implantação de infra-estruturas sociais e económicas, principalmente.  

 

MATERIAL E MÉTODOS  

 

Caracterização da Área de Estudo 

 

Segundo PADCT (2015), a área total do Distrito da Cidade de Tete é de aproximadamente 

287 km2. Na administração municipal actual, a Cidade de Tete é composta por nove (9) Bairros, 

nomeadamente: Degue; Chingozi; Filipe Samuel Magaia; Francisco Manyanga; Josina Machel; 

Mateus Sansão Muthemba; Matundo; Samora Machel e M’padué, sendo no entanto, os Bairros 

Chingozi e Matundo, um dos maiores e o primeiro, um dos melhores em termos de arruamento e 

ocupação física do solo. Já o segundo, um dos piores em termos de urbanização, ordenamento 

territorial e saneamento do meio. 

O Distrito da Cidade de Tete localiza-se na região do Baixo Zambeze, Província de Tete, 

tendo como limites geográficos: a Norte e Este, Distrito de Moatize, a Sul pelo Distrito de 

Changara, e por fim, a Oeste pelos Distritos de Marara e Changara, respectivamente. 
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Astronomicamente, a área de estudo localiza-se entre os paralelos 16º 03’ 20’’ e 16º 13’ 20’’   S e 

33º 26’30’’ e 33’37’00’’ E. (Figura 1). 

 
Figura 1. Localização geográfica da área de estudo. 

 

 

Procedimento metodológico 

 

Foi inicialmente empregue a pesquisa bibliográfica para o levantamento de informações 

atinentes a temática em análise, a partir de artigos, livros, dissertações e teses para subsidiar a 

formulação do quadro teórico. Em seguida, aplicaram-se as técnicas de Geotecnologias em 

Ambiente SIG- Sistemas de Informação Geográfica, usando-se o Softwares ArcGIS 10.5 ®, versão 

ARCMap10.5 para a espacialização de fenómenos naturais e antrópicos. Vale ainda destacar que 

foi adquirida uma imagem Orbital da SRTM no site da USGS, com a resolução espacial de 30m 

e, de seguida foi feita a sua correcção geométrica, bem como a selecção do contorno da área de 

estudo, criado shapefile (shp), onde foi sobreposta ao modelo digital de elevação (MDE) e feito o 
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processo de extracção da máscara "Extract by Mask" para se ter apenas o recorte do MDE da área 

de estudo, culminando com a selecção do datum original WGS_84 Zona 36S.  

Posteriormente extraíram-se as curvas de níveis automaticamente no SIG, com a 

equidistância de 30m registadas automaticamente na tabela de atributos, com a finalidade de criar 

a base planialtimétrica, possibilitando à geração de redes de triângulos irregulares (TIN) para dar 

lugar à elaboração do modelo digital de elevação (MDE), com a ferramenta: "Contour", que se 

localiza em Spatial Analyst Tools → Surface. Para a elaboração do TIN foi utilizada uma base de 

dados de curvas de níveis no formato Shapefiles (shp) obtidas automaticamente, como 

anteriormente referenciada. 

Este formato permitiu o cruzamento de informações referente à hipsometria e 

geomorfologia do terreno na ferramenta Arc Toolbox → 3D Analyst Tool → TIN Management → 

Creat TIN no software ArcGIS 10.5. Gerado o TIN, seguiu-se o processo de criação do MDE o 

qual foi convertido do formato raster para Shapefiles obedecendo aos passos de sua transformação 

a partir da ferramenta ArcToolbox → Spatial Analyst Tool → Reclass → Reclassify → Convertion 

Tool → From Raster → Raster to Polygon em ambiente ArcMap 10.5. 

De seguida, elaborou-se o mapa de declividade que representa a inclinação da superfície 

do terreno em relação ao plano horizontal. A partir do layer do limite da área recortada do local da 

pesquisa e, diante dos dados já extraídos automaticamente para a tabela de atributos (curvas de 

níveis) gerou-se o TIN e MDE que transformados em Raster já criados, permitiu a geração do 

mapa de declividade da área de estudo através da ferramenta Arc ToolBox → 3D Analyst Tools → 

Spatial Analyst → Tools → Surfce → Slope no ambiente ArcGis 10.5.  

Para tanto, foi seleccionada a ferramenta Reclassify, seguindo-se a classificação manual e 

o estabelecimento dos intervalos das classes de declividade em percentagem (%) obedecendo a 

sua respectiva tonalidade (cores), o que culminou com a elaboração do mapa final de declividade 

em conformidade com Santos et al (2013).  

 

Obtenção de dados morfométricos 

 

Para análise Morfométrica, foram obtidos seguindo critério estabelecido por Cristofoletti 

(1980) apud Leite, Almeida e Silva. (2012), e Gerber et al (2018) que a seguir são apresentados: 
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 Tabela 1. Apresentação dos parâmetros morfométricos calculados na Bacia Hidrográfica do Rio Zambeze 
Parâmetro  Equação Objectivo Tendência a enchentes 

 
 

Índices de forma 

 
 

--------- 

A avaliação da forma é efectuada a partir do 
cálculo de índices que procuram relações com 
formas geométricas conhecidas. Dentre os 
método destaca-se factor de forma e o índice de 
compacidade: 

 
 

---------- 

Factor forma 
(Kf) 𝐹𝑓 =

𝐴

𝐿ଶ
 

Relação entre largura e comprimento para 
avaliação de geometria  

≥ 0,75 = alta 
0,75 – 0,50 = média 

≤ 0,50 = baixa 
Coeficiente de 
compacidade 

(Kc) 

𝑘𝑐 = 0,28 ∗
𝑃

√𝐴
 

Relaciona a bacia a um círculo  1,00 – 1,25 = alta 
1,25 – 1,50 = média 

< 1,50 = baixa 
Índice de 

circularidade 
(IC) 

𝐼𝑐 =
12.57 ∗ 𝐴

𝑃ଶ
 

 

Quanto mais próximo do valor 1, maior a 
circularidade e mais sujeita a inundações  

> 0,51 = alta 
0,51 = média 

< 0,51 = baixa 
 

Densidade de  
Drenagem 

 

𝐷𝑑 =
𝐿𝑡

𝐴
 

 A densidade de drenagem (Dd) é a relação entre 
o comprimento total de canais e a área da bacia 
e para seu cálculo, devem-se considerar todos os 
rios tanto os perenes como os temporários 

˂ 0,50 Baixa 
0,50 – 2,0 Muito Alta 

2,01 – 3,50 Alta 
˃ 3,50 Mediana 

 
 
 

Área da 
Drenagem (A) 

 
 
 

------- 

Quanto maior for a área da bacia, maior será o 
volume de água que passará pelo seu exutório, 
incitando o efeito das enchentes no interior 
dessa. A área da bacia é toda área plana 
(projectada sobre o plano horizontal) limitada 
pelos divisores topográficos da bacia ou, 
simplesmente, a área drenada pelo conjunto do 
sistema fluvial 

  
 
 

---------- 

Legenda: área da bacia (km²); Dd: densidade de drenagem (km/km²); L: comprimento do canal 
principal (km) e P: perímetro da bacia (km). 
Fonte: Adaptado pelos autores (2021) a partir de Leite, Almeida e Silva (2012) e Gerber et al (2018). 

 
RESULTADOS E DISCUSSÃO 

 

Características Geométricas 

 

As características geométricas são factores determinantes na resposta a inundações de uma 

dada área. De acordo com as análises das características morfométricas e geométricas calculadas 

em conjunto com os mapas temáticos elaborados na interface do ArcMap10.5, foi possível 

caracterizar a Cidade de Tete quantitativamente como será apresentado em síntese a seguir. 

Com as técnicas de geoprocessamento aplicadas neste trabalho, foi possível estimar a 

Cidade de Tete, apresentando uma área de drenagem de 278km2 e um perímetro de 86,80 km.  



 
 

 
Boletim GeoÁfrica, v. 1, n. 3, p. 105-121, jul.- set. 2022 

112 

Figura 2. Hierarquia Fluvial 

 
Fonte: Os Autores (2021). 

 

Quanto ao comprimento do rio, foi obtido em um segmento de linha recta no mapa, entre 

os pontos da foz e determinado ponto situado ao longo do perímetro, obtendo o comprimento desta 

forma de 23 km.  

O resultado da ordem dos rios de acordo com a hierarquia de Strahler (1957), a sua área de 

drenagem é de ordem 4 (quatro) ou quarta ordem, resultando, deste modo, numa área de baixa 

drenagem, isto é, com poucas ramificações (a junção dos rios da primeira, segunda e terceira 

ordem). Desta observação, quanto menor a ordem dos rios, menor também a tendência de 

enchentes nas áreas, pois ao serem modificadas antropicamente, tendem a gerar enchentes locais.  

Para a avaliação das características geométricas, bem como a susceptibilidade da Cidade 

de Tete em questões de ocorrência de enchentes foram analisados os seguintes parâmetros: Ff 

(Factor de Forma), Kc (Coeficiente de compacidade) e Ic (Índice de circularidade). A análise 

destes parâmetros resultou nos seguintes valores na tabela a seguir:  
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Tabela 2. Características geométricas 
Parâmetro  Valor  
O factor de forma Kf 0,54 
Coeficiente de compacidade Kc 1,44 
Índice de circularidade Ic 0,48 

   Fonte: Os autores (2021) 

Estes parâmetros constituem ferramentas indispensáveis na interpretação da tendência da 

bacia hidrográfica às inundações assim como na determinação da sua forma. 

Tabela 3. Valores e interpretação de factor de forma (Ff), índice de circularidade (Ic) e, 
coeficiente de compacidade (Kc). 

Factor 
Forma (Ff) 

Índice de 
Circularidade 

(Ic) 

Coeficiente de 
Compacidade 

(Kc) 

Formato da 
Área 

Interpretação 

1,00 - 0,75 1,00 - 0,8 1,00 - 1,24 Redonda Alta tendência à 
enchentes 

0,75 - 0,50 0,8 - 0,6 1,25 - 1,50 Ovalada Tendência 
mediana à 
enchentes 

0,50 - 0,30 0,6 - 0,40 1,50 - 1,70 Oblonga Baixa tendência à 
enchentes 

 

< 30 

 

< 0,40 

 

> 1,70 

 
Comprida 

Áreas com 
tendência a 
conservação 

   Fonte: Adaptado de Villela e Mattos (1975). 

 

De acordo com a tabela acima, os valores de coeficiente de compacidade (1,44) e factor de 

forma (0,54), evidenciam que a Bacia Hidrográfica do Rio Zambeze na Cidade de Tete possui uma 

forma ovalada/oblonga2, o que caracteriza uma taxa média ou mediana a tendência a enchentes 

devido a predominância de seu formato alongado. “Isso porque quanto menor o factor de forma, 

mais comprida é a bacia e, consequentemente, menos sujeita a picos de enchente, pois o tempo de 

concentração é maior, além do baixo índice de probabilidade em atingir toda a extensão da bacia 

hidrográfica” (CARVALHO E SILVA, 2003 apud JÚNIOR, 2019).  

 
2  Quer dizer que tem a forma ovular, com tendência de reter/acumular águas pluviais nos momentos de precipitações 
intensas e que pode provocar inundações.    



 
 

 
Boletim GeoÁfrica, v. 1, n. 3, p. 105-121, jul.- set. 2022 

114 

O Coeficiente de Compacidade (Kc), também relaciona a forma da bacia com um círculo. 

De acordo com Vilella e Mattos (1975) apud Loo e Machado (2019), consideram que esse 

coeficiente é um número adimensional que varia com a forma da bacia independente do seu 

tamanho. Quanto mais irregular a sua forma, maior será o coeficiente de compacidade. Desse 

modo, um coeficiente mínimo igual à unidade (1) corresponderia a uma bacia circular e, para uma 

bacia alongada, seu valor é significativamente superior a 1. Uma bacia é mais susceptível à 

ocorrência de enchentes mais acentuadas quando seu coeficiente for mais próximo da unidade. 

Já para o índice de circularidade (Ic), o parâmetro revela quão é circular ou alongada uma 

bacia hidrográfica. Para Alves e Castro (2003) apud Bolotari Júnior (2019), uma bacia com índice 

abaixo de 0,51, considerada alongada, favorece o escoamento, e se estiver acima de 0,51, 

considera-se uma bacia mais circular com escoamento reduzido e com alta probabilidade de cheias, 

contrariamente a em diapasão.  

Característica do Relevo 

 

Em relação às características de relevo, Villela e Mattos (1975) apud Loo & Machado 

(2019) referem que o conhecimento das informações sobre altitude é importante devido a 

influência que exercem sobre a precipitação, sobre as perdas de água por evaporação e transpiração 

e, consequentemente, sobre o escoamento superficial das massas líquidas. 

A despeito das características de relevo, observou-se na Cidade de Tete uma altitude 

mínima de 100 m e máxima de 480 m. Com base nesses valores, determinou-se a amplitude 

altimétrica (Hm), a que estabelece a diferença entre a maior e a menor cota da área, neste caso 

particular foi de 380 m, indicando a expressão na área do relevo plano (nos quais predominam os 

processos de sedimentação), com tendências semi-montanhoso (podem ocorrer eventos de 

enchentes apenas de curta duração à jusante) pois tende a ultrapassar os 200m, o que influência 

directamente na quantidade de radiação que a Cidade recebe e, consequentemente, na 

evapotranspiração, na temperatura e na precipitação, pois, quanto maior a altitude, menor a 

quantidade de energia solar que o ambiente recebe e, portanto, menos energia estará disponível 

para esse fenómeno. Além do balanço de energia, a temperatura também varia em função da 

altitude; grandes variações na altitude ocasionam diferenças significativas na temperatura, que, 

por sua vez, também causa variações na evapotranspiração. 
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Trentin e Robaina (2005) afirmam que o mapa Hipsométrico/altitude tem fundamental 

importância na análise da energia do relevo. Ele indica condições mais propícias à dissecação para 

áreas de maior altitude e à acumulação para áreas de menor altitude, factores observados na bacia 

em estudo. 

A declividade indica essencialmente a tendência de baixa velocidade no escoamento 

superficial, aumentando a possibilidade da infiltração de água no solo. Desta forma, segundo 

Borsato e Martoni (2004) a área é considerada com baixa declividade, pois está no intervalo de 0 

a 3%, como ilustra a Figura 3.  

Figura 3. Mapa Hipsométrico e de Declividade 

 

 

Segundo Carvalho e Neto (2012), a amplitude altimétrica e a declividade, definem, em 

parte, a velocidade de escoamento. Quanto menores forem os valores, mais lento é o escoamento, 

aumentando o acúmulo de água. No entanto, ao mesmo tempo em que baixos declives permitem 

uma prevalência maior da quantidade das águas, também favorece, consequentemente, a 

infiltração e evaporação. Assim sendo, a Cidade de Tete, pode ser considerada como de 
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escoamento lento e a evaporação. A partir da análise da declividade foi possível identificar as 

inclinações das vertentes da Cidade de Tete como mostra a tabela abaixo. 

 
Tabela 4. Classes de Declividade 

Classes Área (Km2) Área (%) 
Plano 128,6 44,80 

Suave Ondulado 124,3 43,10 
Ondulado 28,3 9,75 

Forte Ondulado 4,2 1,46 
Montanhoso 1,0 0,35 

Total 287,0 100% 
Fonte: Os autores (2021). 

A classe plana (0 a 3%) encontra-se em ambientes de planície actual da Cidade de Tete, 

representando 44,80% da cobertura da área e, é equivalente a 128,6 km2 da área total da Cidade 

que coincide com a maior parte mais baixa da bacia hidrográfica. Por sua vez, a classe suave 

ondulado (3 a 8%) distribui-se ao longo da Cidade, representando, 43,71% (124,3 km2) da área 

total e coincide com a área mais habitada da Cidade de Tete.   

A classe ondulada (8 a 20%) representa 9,75% (28,3 km2) do total da área. Ao passo que a 

classe fortemente ondulada (20 a 45%), representa 1,46% (4,2 km2). Por último, a classe 

montanhosa (> 45%) com 0.35% corresponde a 1,km2. 

As inclinações de relevo podem influenciar a velocidade de escoamento, humidade do solo 

e a contribuição de água subterrânea e o escoamento do curso de água. Sala e Gasparetto (2010) 

enfatizam a importância de considerar a declividade como controladora de boa parte da velocidade 

do escoamento interferindo no tempo que a água da chuva leva para chegar até os leitos das 

drenagens. A baixa amplitude altimétrica resulta em baixos valores de razão de relevo, sugere uma 

área com relevo relativamente plano (44%). Considerado com uma área de ligeira susceptibilidade 

à erosão, pode-se, portanto, considerar como de baixa fragilidade ambiental aos processos 

denudacionais em maior parte da sua extensão. 

Características da Rede de Drenagem 

 

As características da Rede de Drenagem fornecem uma referência sólida da geologia de 

qualquer área de estudo, pois em terrenos com materiais duros, há uma ligeira dificuldade da 
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penetração de água e não se formam novos cursos de água. Nestes casos por exemplo, os valores 

do mesmo podem variar de 0,5 km2 á 3 km2, em áreas com drenagem pobre, de 3 á 7 km2 em áreas 

com drenagem médias e 7 km2 ou mais, em áreas suficientemente bem drenadas, mas apresentam 

pouca infiltração e melhor estruturação dos canais. Para a realidade da área de estudo, apresentou-

se 0,52 km/km2 para a análise da densidade de drenagem, indicando que esta região apresenta 

baixa relação entre o comprimento de rios que é de 23 km e a área da bacia que é de 278 Km2, 

indicando um eficiente escoamento de fluxo de água e boa infiltração para o lençol freático. O 

baixo valor para esse parâmetro segundo Christofoletti (1980), classifica-se como uma  região  

pouco susceptível a processos erosivos naturais. 

Desta maneira é possível inferir que a densidade de drenagem verificada para área de 

estudo é essencialmente o reflexo da presença de um relevo predominantemente plano, conforme 

visto na Figura 3 (declividade e hipsometria). 

O comprimento do rio principal é um índice que compreende a distância que se estende ao 

longo do canal fluvial desde a desembocadura até uma determinada nascente no outro extremo. O 

critério utilizado para a determinação do comprimento do rio Zambeze foi o estabelecido por 

Horton (1945), no qual o canal de ordem mais elevada corresponde ao rio principal, que neste caso 

é um canal de 4ª ordem. 

 

Tabela 5. Resultados dos atributos Morfométricos da Cidade de Tete 
 

 Características Morfométricas Unidades Valores 
Obtidos 

 

 

Características 
Geométricas 

Área km² 287,08 

Perímetro Km 86,80 

Número de Canais da primeira ordem __ 627 

Coeficiente de Compacidade (Kc) __ 1,44 

Factor Forma (Ff) __ 0,54 

Índice de Circularidade (Ic) __ 0,48 

 

Características do 
Relevo 

Altitude Máxima M 480 

Amplitude Altimétrica (Hm) M 280 

Altitude Mínima M 100 
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Características da 
Rede de 
Drenagem 

Comprimento do canal Principal (L) Km 529 

Comprimento total dos Canais Km 322,45 

Comprimento Vectorial do Canal 
Principal 

Km 23 

Densidade de Drenagem (Dd) Km/km2 1,12 

Ordem da Bacia  4 

        Fonte: Os autores, 2021. 

 

Mapeamento das áreas susceptíveis 

 

O mapa de áreas susceptíveis às inundações foi dividido em cinco classes, conforme pode-

se observar na Figura 4. 

Figura 4. Mapa de Risco a inundações 
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O mapa acima, evidência que cerca de 39,9 a 40,40% da área da Cidade de Tete está 

exposto ao alto e médio risco de inundações, respectivamente, seguindo-se por 16,2% de baixo 

risco e 3.5% de cobertura de áreas sem algum risco. Sá (2016) afirma que o grau de vulnerabilidade 

é determinado pelo tipo de ocupação que existe no local onde irá incidir o evento. Há também 

aspectos de índole social importantes no aumento da vulnerabilidade, tais como a idade das pessoas 

que poderão ser afectadas, o seu estado de saúde, a possibilidade de fuga ou abrigo durante a 

ocorrência do evento, entre outros. 

 

CONSIDERAÇÕES FINAIS 

 

Do estudo efectuado depreendem-se as seguintes ilações: 

Os resultados alcançados demonstram que, do ponto de vista de relevo, a Cidade de Tete 

comporta-se como uma área de baixa fragilidade ambiental, evidentemente desconsiderando-se os 

factores antropogénicos relacionados com a ampla e extensiva ocupação humana em áreas 

susceptíveis. 

A análise das características morfométricas permitiu verificar que a mesma, em condições 

naturais, apresenta média susceptibilidade a enchentes, corroborada pelos valores de coeficiente 

de compacidade, coeficiente de forma, densidade de drenagem e índice de circularidade obtidos, 

bem como, pelas características hipsométricas e de declividade observadas. 

A partir das características da rede de drenagem, pôde-se também concluir que a área 

apresenta uma baixa densidade de drenagem, sugerindo haver em momentos de precipitação, um 

moderado escoamento superficial e têm uma área suficiente pequena para manter perenes os cursos 

de água. 

As formas de construções informais que perfazem a maior parte da Cidade de Tete, estão 

de certo modo em risco, devido a fragilidade técnica e resiliência a eventos climáticos.  

O uso de Geotecnologias foi de fundamental importância por permitir que as análises 

morfométricas e de susceptibilidade da bacia fossem realizadas com celeridade. As avaliações 

realizadas neste trabalho propiciaram embasamento para elaboração preliminar do planeamento e 

gestão do uso do solo na Cidade de Tete. 
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Os locais com baixa susceptibilidade às inundações são os bairros de expansão como 

Chimbonde, Chimadzi e Canongola, esses dois últimos com alta susceptibilidade de deslizamento 

de Terra. Bairros Chingozi, a Norte e a Sudeste dos Bairros Filipe Samuel Magaia, Francisco 

Manyanga e Josina Machel, no vale do Nhartanda, mostraram que são áreas propensas a 

inundações periódicas.  
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